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 (a)  (b)  (c)  (d)   (b)

4. 
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 (a)  (b)  (c)  (d)   (b)
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 (a)  (b)  (c)  (d)    (b)

8. 
 (a) Fujitsu’s ICL VME(b) Hitachi’s Z800 (c) a orb (d)  (c)

9. 
 (a) (b) (c) (d) (d)
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 (a) (b) (c) (d) (d)
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 (a) (b) (c) (d) (d)
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16. 
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Vijay PublicationsComputer Question Bank 6

1. 
 (a)   (b)  (c)   (d)  (c)

2.  
 (a)  (b)     
 (c)   (d)   (c)

3. (ICs) 
 (a)   (b)     (c)   (d)  (c)

4.  
 (a)    (b)    (c)   (d)  (d)

5.  
 (a)  1953 (b)  1961    

 (c)  1955 

 (d) 1961  (c)

6. 
 

 (a)    (b)    (c)  (d)  (b)

7. 
 (a)   (b)     (c)  (d)  (d)

8.  
 (a)   (b)  (c)  (d) (b)

9. 
 (a)  (b) 
 (c)   (d)  (b)

10.  
 (a)    (b)     
 (c)   (d)  (a)

11. 
 (a)    (b)  (c)   (d)  (d)

12. (VLSI) 
 (a) ULSI (b) CLSI (c) LSI (d) KLSI (a) 

13. PARAM 8000 
 (a) 1190 (b) 1991 (c) 1989 (d) 1992 (b) 

14. 
 (a)  (b)  (c)  (d)  (b) 

15. 

v/;k; 1INTERNAL ASSESSMENT

Publications, Sikar

RS-CIT परी�ा� म� 100% ��� का समावेश



1. 
 (a)  (b)  (c)  (d)   (d)

2. 
 (a)  (b)  (c)  (d)   (d)

3. 
 (a) ON (b) Ctrl (c) Alt (d) Start  (d)

4. ON/OFF
 (a)  (b)  (c)  (d)   (a)

5. 
 (a)  (b)  (c) a, b  (d)   (c)

6. 
 (a)  (b) (c)  (d)   (c)

7.  RAM 

  (d)(a) (b) (c) (d) a or b     
8. 
 (a)  (b) (c)  (d)  (c)

9. 
 (a)  (b)  (c)  (d)   (d)

10. 
 (a)  (b)  (c)  (d)   (b)

11. 
 (a)  (b)  (c)  (d)   (d)

12. EPROM  

  (a)(a) (b) (c) (d)     
13. 
  (b)(a) (b) (c) (d)    
14. 
  (a)(a) (b) (c) (d)      
15. 
  (d)(a) (b) (c) (d)     
16. 
 (b)(a) (b) (c) (d)      
17. 
  (a)(a) (b) (c) (d)     
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v/;k; 2INTERNAL ASSESSMENT
1. 
 (a)  (b)  (c)  (d)  (a) 

2. 
 (a)  (b) 

(c)  (d)  (c) 

3. 
 (a)  (b)  (c)  (d)  (a) 

4. RAM 
 (a)  (b) 

(c)  (d)  (b) 

5. 
 (a)  (b) 
 (c)  (d)   (c) 

6. 
 (a)  (b)  (c)  (d)  (b) 

7. ALU 
 (a)  (b)  (c)  (d)  (a) 

8. 
 (a) 2 (b) 1000 (c) 8 (d) 1/8 (c) 

9. 
 (a)  (b) 

(c)  (d)   (b) 

10. OMR 
 (a)  (b) 

(c)  (d)  (b) 

11. 
 (a)  (b)  (c)  (d)  (d) 

12. ENIAC 
 (a)  (b) 
 (c)   (d)   (a)

13. 
 (a)  (b)  (c) (d)  (b) 

14. 
 (a)  (b) 

(c)  (d)  (c) 

15. 

Publications, Sikar

आज ही ऑडर कर�

सं�था क� नाम से कवर पेज क� साथ बुक बनवाए



1. 
 (a)  (b) (c) (d)    (a)

2. 
 (a) (b) (c) (d)    (b)

3. 
 (a)   (b) (c) (d)   (c)

4. (Win. 11/10/8/7/97/XP/Vista)


 (a)    (b) (c)  (d)   (a)

5. IOS, Symbian 
 (a)  (b) (c)  (d)   (b)

6. 
 (a) (b) (c)  (d)   (d)

7. 
 (a)   (b)  
 (c)   (d)   (d)

8. 
 (a)     (b)       (c)       (d)  (b)

9.       
 (a)  (b)  (c)  (d)    (c)

10.                
 

 (a)  (b) (c) (d)    (a)

11.        
  

 (a)  (b) (c) (d)    (b)

12. 
 (a)  (b) (c) (d)  (d)

13.    
 (a) 


 (b)        
 (c) 
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Ø  



Ø  




Ø 


Ø  Right  
Properties Hidden  (Feature)   
             “Hide 

Selected Items”
Ø  Home View Show      

 Hidden Items 

Ø  

 
 

Ø 



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v/;k; 3INTERNAL ASSESSMENT
1. 
 (a)  (b)  (c)  (d)  (c) 

2. 
 (a) Enter+ Delete (b) Ctrl+Delete (c) Shift+Delete (d) Alt+ Delete (c) 

3. 
 (a)  (b)  (c)  (d)  (a) 

4. 
 (a)  (b)  (c)  (d)  (a) 

5. DLL 
 (a)  (b) 

(c)  (d)  (a) 

6. 
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1. 
 (a)  (b)  (c)  (d)   (c)

2. 
 (a)  (b)  (c)  (d)   (a)

3. 
 (a)  (b)  (c)  (d)   (a)

4. 
 (a)  (b)  (c)  (d)   (a)

5. 
 (a)  (b)  (c) a or b  (d)   (c)

6. 
 (a) (Internet Service Provider-ISP)

 (b) (Modem)  (c) a or b      (d)   (c)

7.  (ISP) 
 (a)  (b) 
 (c)   (d)    (d)

8.  ISP 
 (a)  (b) 
 (c)  (d)    (d)

9. 
 (a)  (b)  (c)  (d)   (d)

10. 
 (a) (b) (c)  (d)   (b)

11. 
 (a) (b) (c) (d)   (a)

12. 


 (a)  (b)  (c)  (d)   (d)

13. Modulator-Demodulator
 (a) Modem (b) Data  (c) ISP (d) External  (a)

14. 
 (a)  (b) (c)  (d)   (d)

bUVjusV dk ifjp;
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बु�स ऑडर क� िलए संपक� करे:-

+91-998-398-7766




Ø RTE 25% 






Ø (25MB) 



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1. 
 (a)  (b)  (c)  (d)  (d) 

2. 
 (a)  (b) 

(c)  (d)  (b) 

3. 
 (a)  (b)  (c)  (d)  (a) 

4. 
 (a)  (b)  (c)  (d)  (a) 

5. 
 (a)   (b) 

(c)  (d)  (a) 

6. 
 (a)  (b)  (c)  (d)  (a) 

7. 
 (a)  (b) (c) (d)  (b) 

8. 
 (a)  (b)  (c)  (d)  (b) 

9. 
 (a)  (b)  (c)  (d)  (d) 

10. 
 (a)  (b)  (c)  (d)  (c)

11. 
 (a)  (b)  (c)  (d)  (b) 

12. 
 (a) AQL (b) NetZero (c) MSN (d) CompuServe (b) 

13. 

Publications, Sikar

सं�था क� नाम से कवर पेज क� साथ बुक बनवाए



1. 
 (a) Electronic (b) Automatic (c) Economic (d) E-Commerce (a)
2. 
 (a) Internet (online) Banking (b) E-Commerce  (c) E-mail(d) Google (a)
3. 
 (a)  (b)   (c)   (d)  (d)

4. 
 (a)  (b)  (c) a orb (d)  (c)

5. 
 (a) (24x7) (b) 
 (c)  (d)  (d)

6. 
 (a)  (b)  (c)  (d)  (d)

7. 


 (a)  (b)  (c)  (d)  (a)

8. 
 (a)  (b)  (c)  (d)  (b)

9. 
 (a)  (b)  (c)  (d)  (a)

10. 
 (a)   (b) 
 (c)    (d)  (d)

11. 
 (a)  (b)  (c)  (d)  (a)

12. 
 (a)  (b)  (c) a or b  (d)  (c)

13. 
 (a) (b) (c)  (d)  (d)

14. 


 (a)  (b) HTTPS (c) a or b  (d) .gov.in (c)

15. 
 (a) 13         (b) 14 (c) 15 (d) 16 (d)
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 (a)  (b)  (c)  (d)  (a)

75¸ 
 (a)   (b) 
 (c) a or b   (d)  (c)

76 
 (a)  (b)  (c)  (d)  (b)

77 
 (a)  (RFID)  (b) (RID)

 (c) a or b   (d)  (a)

78 
 (a)    (b)  (c)  (d)  (c)

79 
 (a)   (b) 
 (c)  (d) (c)

Ø PIN, OTP, CVV Internet Banking   


Ø :          -

 *99#
 (TSP- Telecom Service Providers)
 Self-
Service ( - MMID

Mobile Money Identifier)M-PIN
Ø        Radio Frequency Identification 

(RFID) Technology


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v/;k; 5INTERNAL ASSESSMENT
1.  

 (a) SBI  (b)            (c)  (d) SBI  (c)

2. RTGS : ?  

 (a) 10,000  (b) 10,000 1          
 (c) 2 (d)   (c)

3. RTGS ,? 
 (a)  (b)   (c)  (d)   (c)
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1. 
 (a) E-Commerce (b) Internet Banking (c) E-Payments (d) E-Jobs (a)

2. B2B, B2C, C2B, C2C, M-Commerce 
 (a) E-Commerce (b) Internet Banking (c) E-Payments  (d) E-Jobs (a)

3. B2C 
 (a) Flipkart (b) Snapdeal (c) Paytm (d)  (d)

4. 
 (a) B2C (b) B2B (c) C2B (d) C2C (a)

5. B2B 
 (a) www.india.alibaba.in (b) www.amazonbusiness.in 
 (c) a  b   (d)   (c)

6. 
 (a) B2C (b) B2B (c) C2B (d) C2C (b)

7. C2B Online Post
Companies

 (a) www.india.alibaba.in (b) www.amazonbusiness.in 
 (c) www.thefreemortgagecalculator.com (d)  (c)

8. 
 (a) B2C (b) B2B (c) C2B (d) C2C (d)

9. 
 (a) B2C (b) B2B (c) C2B (d) C2C (c)

10. 
 (a) M2C (b) Moblie  (c) Moblie Commerce(d) C2C (c)

11. 
 (a)   (b) 
 (c)   (d)   (d)

12. 


 (a) E-Portal (b) E-Bazaar (c) Paytm (d)  (b)

13. 
 (a) (b)   (c)  (d)  (d)

14. SNS 
 (a) Social Networking Service (b) Social Networking Sites
 (c) Social Nature Service (d) Social National Service (a)

bUVjusV ds vuqiz;ksx
(Internet Applications)6
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v/;k; 6INTERNAL ASSESSMENT
1.  

 

 (a)   (b)     (c)   (d)  (c)

2.  

 (a)  (b)     (c)  (d)  (b)
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5. (OS)
 (a)   (b)  (c)  (d)  (d)

6. OS


 (a)  (b)  (c)  (d)  (c)

7. 
 (a)   (b)  (c)  (d)  (d)

8. 
 (a)  (b)  (c)  (d)  (a)

9. 
 (a)  (b)  (c) (ASTRO) (d)  (c)

10. 
 7.0

 (a)  (b) 
 (c)  (d)  (a)

11. 
 (a)   (b)  (c)  (d)   (a)

12. 
 (a)   (b) 
 (c)   (d)   (c)

13. 
 (a)  (b)  (c)  (d)  (d)
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v/;k; 7INTERNAL ASSESSMENT
1. ßæ§üÈ¤æ§ü ×æÙ·¤æð´ ·¤æð ÂçÚUÖæçáÌ ·¤ÚUÙð ·ð¤ çÜ° ·¤æñÙâæ â´»ÆUÙ çÁ�×ðÎæÚU ãUñ?   

 (a) lEEE (b) ISO (c) ITU  (d) IETF  (a)

2. ŽÜêÅêÍ Ì·¤Ùè·¤ ç·¤â Èý¤è·ð¤âè ÚÔU´Á ×ð´ ·¤æ× ·¤ÚUÌè ãñU?   
 (a) 2.4GHz (b) 5 GHz (c) 1GHz  (d) 10 GHz  (a)

3. ÁèÂè°â¤(GPS) ·¤æ Âê‡æü M¤Â €Øæ ãñU?   

 (a)  (b)  

 (c)  (d)  (b)

4. 


 (a)  (b)  (c)  (d)   (c)

5. 
 (a)  (b)  (c)   (d)   (b)

6. 
 

 (a) 900 MHz (b) 2.4 GHz (c) 5 GHz (d) 10 GHz  (c)
7.  (SIG) 
 (a)   (b)     
 (c)  (d)  (b)

8. 


 (a)  (b)  (c)  (d)    (c)

9. 


 (a) WEP         (b) WPA2      (c) WPS (d) WPA3  (c)
10. 
 (a) 2.4 GHz 5 GHz (b) 1 GHz 10 GHz              

 (c) 5 GHz 10 GHz (d) 2.4 GHz 3 GHz (a)

11. 
 (a)   (b) 
 (c)  (d)  (c) 

12. 
 (a) 1 MBPS (b) 2 MBPS (c) 5 MBPS (d) 10 MBPS (b) 

13. 
 (a) 2.0 (b) 3.0 (c) 4.0 (d) 5.0 (d) 

14.           

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1. 
 (a)  (b) HP  (c) Dell (d) HP  (a)

2. Content Ghosted Text 
 (a) Page Borders(b) Page Color  (c) Watermark (d)  (c)

3. 
 (a)  (b)  (c)  (d)  (a)

4. 
 (a) StartàAll Apps àWord (b) RunàwinwordàOk
 (c) a or b   (d)  (c)

5. Save, Redo, Undo, Print


 (a) (b)  (c)  (d)  (a)

6. Tabs Commands
Commands 

 (a)  (b)  (c)  (d)  (d)

7.  Home, Insert, Page Layout, References, Mailings, (

Review, View) 

 (a)  (b)  (c)  (d)  (b)

8. 


 (a)  (b)  (c)  (d)  (a)

9. 
Look 

 (a)  (b)  (c)  (d)  (c)

10. 


 (a)  (b)  (c)  (d)  (a)

11. Viewing Area 
 (a)  (b)  (c)  (d)  (c)

12.          
 (a) (b)  (c)  (d)  (a)

13. 
 (a)  (b)  (c)  (d)  (a)

14. 
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v/;k; 8INTERNAL ASSESSMENT
1. 
 (a)(a) (b)  (c)    (d) 
2. 
 (a) Save
 (b)             
 (c) File name  (d)   (d)

3. 
 (a)(a) winword.exe (b) word.exe (c) msword.exe (d) word2003.exe 

4. 
 (a)  (b) 

(c)  (d)  (b)

5. 2019
 (a)                   (b) 
 (c)  (d)  (c)

6. 
 (a)  (b)             
 (c)  (d)   (a)

7. 2019


 (c)(a) (b)             (c)  (d)    
8. 
 (a) (b)    file tab>Info>Properties 
 (c) (d)    (d)

9. 


 (c)(a)  (b)   (c)  (d)  
10. 
 (a)(a) (b)  (c)   (d) 
11. 


 (a)  (b)  (c)  (d)  (b) 

12. 


 (a)  (b)  (c) (d)  (c) 

13. 
 (a)  (b) 
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1. 
 (a)  (b)  (c)  (d)  (c)

2. 
 (a)  (b)  (c)  (d)  (d)

3.       
 (a)  (b)  (c)  (d)  (d)

4. Save, Save As, Open, Close, Info, Recent, New, Print, Document Sharing, 

Help 
 (a)  (b)  (c)  (d)  (a)

5. 
 (a) 1 (b) 2 (c) 3 (d) 4 (a)

6. 
 (a) Shift + F11 (b) Ctrl + F1 (c) Alt +F1 (d) Alt+Ctrl+F1 (a)

7. 
 (a) 1048576 (b) 16384 (c) a or b  (d)  (c)

8. 
 (a)  (b)  (c)  (d)  (a)

9. 
 (a)  (b) 
 (c)   (d)   (d)

10. 
 (a) Alt (b) Shift (c) Ctrl (d) Win (c)

11. 
 (a)  (b)  (c)  (d)  (d)

12. 


 (a)  (b)  (c)  (d)  (b)

13. 


 (a)  (b)  (c)  (d)  (c)

14. 
 (a) Wrap Text (b) Horizontal (c) Vertical (d) Content (a)
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v/;k; 9INTERNAL ASSESSMENT
1.  2019AGGREGATE
 (a)    (b)     
 (c)   (d)  (a)

2. 2019
 (a) Review > Window > Split (b) Page Layout > Split (c) Review > Split   (d) view > Split  (a)
3.   (DSUM)  ,     
 (a) OR   (b) AND (c) a or b (d)  (a)

4. 
 

 (a) DDB  (b) ACCRINTM (c) INT_ACCRUED   (d) MINTACCR (b)

5.  2019HLOOKUPVLOOKUP? 
 (a) HLOOKUP ,   VLOOKUP 
 (b) HLOOKUP ,  VLOOKUP 

 (c) HLOOKUP ,  VLOOKUP 
 (d) HLOOKUP VLOOKUP ; (a)

6. ?
  (b) (a) MAX() (b) AVG() (c) MIN() (d) SUM()
7. 2019 ?
 (c)(a) Data > From (b) Data > Table  (c) Data > Sort (d) Data > Subtotal 
8. 
 (a) F8 (b) F2 (c) F4 (d) F5 (c) 

9. B10 


 (a)=DCOUNT(A1:D9,Marks,F2:G3)     (b) = DCOUNT (A1:D8, 4, F2:G3
(c) =DCOUNT(A1:D8,Marks,F2:G3)     (d) a or b  (b) 

10. 



 (a) Biology and Suresh (b) Biology and Suresh, Vijay
(c) Biology and Vijay (d)   (b) 

11. 
 (a) Ctrl+ Space Bar  (b) Ctrl + Page Up   (c) Ctrl + Enter      (d) Ctrl + C  (a) 
12. 
 (a) C (b) VB (c) Visual C++ (d) Java (b) 

13. 
 (a) Count() (b) Num() (c) Sum() (d) Chkum() (a) 

14. 
 (a)  (b)  (c)  (d)  (a) 
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1. 


 (a)  (b)  (c) a or b  (d)  (c)

2. 
 (a)  (b)  (c)  (d)  (d)

3. 
 (a)  (b)  (c)  (d)  (d)

4. 
 (a)  (b)  Slide SorterView  Normal View
 (c) Reading View  (d)   Notes Page View (b)

5. 
 (a) Start > PowerPoint>PowerPoint> Blank Presentation> Ok

  (b) Start > PowerPoint   (c) Start > Blank Presentation     (d)  (a)

6. 
 (a) X  (b) Ctrl + W

 (c) a or b    (d) Ctrl+Alt+W (c)

7. 
 (a)  (b)  (c)  (d)  (a)

8. 
 (a) Save (b) Save As (c) Open (d) New (b)

9. 
 (a) Save (b) Save As (c) Open (d) New (c)

10. 


 (a) Save (b) Save As (c) Recent (d) New (c)

11. 
Save As type 

 (a) Powerpoint 97-2003 Presentation (.ppt) (b) PDF (.pdf)
 (c) Powerpoint Presentation (.pptx) (d) XPS Documrnt (.xps) (c)
12. Version  

Save As type 
 (a) Powerpoint 97-2003 Presentation (.ppt) (b) PDF (.pdf)
 (c) Powerpoint Presentation (.pptx) (d) XPS Documrnt (.xps) (a)
13. 
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Section Zoom
Insert Zoom
Slide ZoomInsert Slide Zoom 


Ø Picture Tools>Format Size    
Crop Height and Width 

Ø Insert>Shapes
Drawing Tools>Format Shapes Styles 


Ø 
Edit Alt Text Alt Text 
Mark as Decorative 

Ø 
Format Arrange Bring Forward Send Backward 


Ø 


Ø Delete


Ø Design 

Table Styles 
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v/;k; 10INTERNAL ASSESSMENT
1. 
 (a) 
 (b)  
 (c) = FONTCOLOR()   (d)  (a)

2. 3D
 (a) 3D
 (b) 3D  
 (c) 3D
 (d)  3D  (a)

3. 2019
 (c)(a) Ctrl+S (b) Ctrl+R   (c) Alt+R (d) Ctrl+B 

4. 2019
   (b)(a) Ctrl+A (b) Alt+A   (c) Alt+B (d) Ctrl+X

5. 

Publications, Sikar

बु�स ऑडर क� िलए संपक� करे:-
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1. 
 (a)  (b)  (c)  (d)  (c)

2. 


 (a)  (b)  (c) a or b  (d)  (d)

3. 


 (a)  (b)  (c)    (d)  (d)

4. 
 (a) SPY, INFECTED, TROJAN, HACKER (b) HACKING 
 (c) PHISHING, VIRUS, THEFT, WORM  (d)  (d)

5. 


 (a)  (b)  (c) VLC   (d)  (a)

6. 


 (a)  (b)  (c)  (d)  (a)

7. 


 (a)  (b)  (c)  (d)  (b)

8. 


 (a)  (b)  (c)  (d)  (a)

9. 
 (a)  (b)  (c)  (d)  (d)

10. 
 (a)  (b)  (c)  (d)  (d)

11.     
       

 (a)  (b)  (c)  (d)  (b)

12. 


 (a)  (b)  (c)  (d)  (a)
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v/;k; 11INTERNAL ASSESSMENT
1. 
 (a)  (b)  
 (c) (d)  (b)

2. 


 (b)(a) (b)  (c)  (d)  
3. URLHTTPS 
 (a) (b)  
 (c)   (d)  (a)

4. 
 (d)(a) (b)  (c)  (d)  
5. 
 (c)(a) (b)  (c)  (d)  
6. 


 (d)(a) (b)  (c)  (d)  
7. 
 (b)(a) (b)  (c)  (d)  
8. ....


 (b)(a) (b)  (c)  (d)  
9. 
 (a) (b)  
 (c) (d)  (c)

10. 


 (a) (b)   
 (c)  (d)  (b)

11. 


 (a)  (b)  (c)  (d)  (c) 

12. 


 (a)  (b)  (c)  (d)  (c) 

13. 
 (a)  (b) 
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1. 
 (a)  (b)  (c) a or b  (d)  (c) 

2. 
 (a)  (b)  (c) a or b  (d)  (c)

3. 
 (a) 

(b) 
 (c) a or b   (d)     (c)

4. 
 (a) (b)  (c)  (d)   (a)

5. 
 (a) (b)  (c)  (d)   (a)

6. 
 (a)  (b)  (c) (d)  (d)

7. 
 (a)   (b) 
 (c)  (d)   (d)

8. cal.new
 

 (a)  (b) 
(c)  (d)  (a)

9. doc.new
 

 (a)  (b) 
(c)  (d)  (b)

10. 
 (a) 

  (b) 


 (c) 
 (d)   (a)

11. 
 (a) Insert>Page Set Up (b) File>Page Set Up

(c) Page>Page Set Up (d) Menu bar>Page Set Up (b)
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 «  (Sites) (site.new)

 «  (Currents)
Ø 






Ø 


Ø 




Ø 



Ø   Calc 
 
 ‘What if’

  Calc 2D 3D 

Ø     



Ø 



Ø          


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v/;k; 12INTERNAL ASSESSMENT
1. 
 (a)   (b)  (c) a or b    (d)  (c)

2. 
 (a) .odp  (b) .ods (c) .odt. (d) .odb (c)
3. 
 (a)   (b)  
 (c) (d)  (d)
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1. िवंडोज 11 म� ............. फ��शन है जो आपको िकसी भी तीसरी पाट� सीडी/डीवीडी बिन�ग 
सॉ�टवेयर का उपयोग िकए िबना िकसी CD या DVD म� सभी �कार की फाइल� को बन� करता है।

 (a) अंतिन�िहत िड�क बिन�ग (b) �थम िड�क बिन�ग����� 
 (c) (a) और (b) दोन�  (d) उपरो�त म� से कोई नह� (a)

2. स��� ाम�ी/डट� ा (सगंीत, त�वीर,�  द�तावजे आिद) को CD/DVD या अ�य �रकॉड� करने यो�य िड�क पर 
िलखना या कॉपी करना कहलाता ह।ै

 (a) ����पे�ट करना (b) कट करना����� (c) बन� करना              (d) उपरो�त म� से कोई नह� (c)

3. ���यिद आप ऑिडयो या वीिडयो (MP3, AVI, MP4, WMV फाइ�स) को DVD पर बन� करना चाहते 
ह�, और आप चाहते है िक आपकी ये वीिडयो फाइल िकसी भी DVD �लेयर पर चले तो आपको बन� करने 
से पहले इन वीिडयो फाइल� को िकस �ा�प म� कनवट� करना होगा।

 (a) MP4 (b)  (c) MP3 (d) AVI DVD (b)

4. एक से अिधक फाइल� या फो�डस� को एक साथ चुनने क� िलए-
 (a) ���पहले (शीष�) फाइल  या फो�डर पर बायाँ-��लक कर�, िफर की-बोड� क� CTRl+ A दबाएं
  (b) पहले फाइल या फो�डर पर बायाँ-��लक कर�, िफर की-बोड� पर ’िश�ट’ क��जी � को दबाए रख� और 

तब तीर ( ) को नीचे दबाए रख� और अपने क��जीपटल पर तब तक दबाएं रख� जब तक िक सब क�छ सेले�ट ¯

न हो जाए। (c) (a) और (b) दोन�                                (d) उपरो�त म� से कोई नह� (c)

5. MS Word म� फाइल/द�तावेज को ि�ंट करने क� िलए-
 (a) File Menu Print Print  (b) Ctrl + P ® ® 

  (c) (a) और (b) दोन�  (d) उपरो�त म� से कोई नह� (c)

6. CD/DVD को खंर�च से दूर रख�। यह �ाइव की ........... की �मता को �भािवत करता है।
 (a) Read (b) Write����� (c) (a) और (b) दोन�    (d) इनम� से कोई नह� (c)

7. िवंडोज मैक पर ि�ंट करने क� िलए क��जीपटल शॉट�कट की �योग की जाती ह�।
 (a) Ctrl + P (b) CMD + N (c) Ctrl + N (d) CMD + P (d)

8. ���पीसी/लैपटॉप क� यूएसबी पोट� म� यूएसबी िडवाइस या पेन �ाइव लगाने पर िदखाई देता है।
 (a) My Computer म� USB िडवाइस   (b) My Computer म� C �ाइव
 (c) My Doucment   (d) उपरो�त म� से कोई नह� (a)

9. ���क�छ भी मु�ण/ि�ंट करने से पहले ......... का इ�तेमाल करना चािहए-
 (a) ����ि�ंट पूवा�वलोकन (b) Ctrl + P (c) ि�ंट डॉ�यूम�ट (d) उपरो�त सभी (a)

10. HDMI क�बल उ� गुणव�ा वाले संक�त क� साथ-साथ ......... और ...... दोन� संक�त� को एक 
साथ ले जाने की �मता रखता है।

 (a) ����ऑिडयो  (b) वीिडयो����� (c) (a) और (b) दोन�    (d) इनम� से कोई नह� (c)

vkbZ- Vh- ds mi;ksxh vuqiz;ksx
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1. िवंडोज 11 म� CD/DVD बन� करना- Ø PC क� CD/DVD Writer म� खाली CD/DVD डाले।
  क��यूटर पर उस �थान पर जाएं जहाँ फाइल� और / या फो�डस� सं�हीत ह�।�� Ø

  उन सभी फाइल� और / या फो�डस� का चयन कर� िज�ह� आप बन� करना चाहत� है।Ø

  चयिनत फाइल� और / या फो�डस� पर राइट-��लक कर,�  Send पर जाएं और िफर CD/DVD Writer Ø

चनु� (DVD RW Drive (:D) या (CD RW Drive (:E),Bluetooth device, Desktop Fax, Mail 
आिद हो सकते ह।�   अब एक छोटी सी िवडंो िदखाई जाएगी और यहाँ आप Disc Title पर अपनी िड�क क�  Ø

िलए एक शीषक�  दज� कर।े  With a CD/DVD Player चनु� और Next पर ��लक कर।�Ø

  जब कॉपी हो जाए तब Drive Tools (शीष/� Top) पर ��थत) पर ��लक कर� और Finish Burning चनु।�Ø

2. एक से अिधक फाइल� या फो�डस� को एक साथ चुनने क� िलए-
 (a) ���पहले (शीष�) फाइल  या फो�डर पर बायाँ-��लक कर�, िफर की-बोड� क� CTRl+ A दबाएं
  (b) पहले फाइल या फो�डर पर बाया-ँ��लक कर,�  िफर की-बोड� पर ’िश�ट’ कज�� ी � को दबाए रख� और तब 

तीर ( ) को नीचे दबाए रख� और अपने कज�� ीपटल पर तब तक दबाएं रख� जब तक िक सबस कछ�  सले�ेट नहो ¯

जाए।  ि�टं �ॉपट� �िदशत�  होने पर ि�टंर िवक�प� पर िनभर�  करते हएु, आप अ�य म�ुण िवशषेता� का Ø �
चयन कर सकते ह� जसै-े सभी प�ृठ� का मिु�त करना, कव� ल कछ�  खास प�ृठ, ओ�रएटंश� न (पो�ट� � और 
लड� �कप� ), पपेर का िन�चत आकर  तथा दा� और, मिु�त द�तावजे का एक पवूाव� लोकन आिद।

3. फाइल को यूएसबी/पेन �ाइव म� �ांसफर करने क� िलए फाइल पर राइट ��लक कर�। एक �ॉप डाउन मेनू पर 
राइट ��लक करने क� बाद Popup िदखाई देगा, अपने कस�र को Send To और USB Device/Pen 

Drive  का चयन कर�। यूएसबी िडवाइस या PC से ड�टा Copy और Paste कर�। 
4. सभी आधुिनक ट�लीिवजन और �ोजे�टर� म� एक से अिधक पोट� होते ह� जो क��यूटर �ारा उ�प� इमेज को 

�ा�त करने और �दिश�त करने की सुिवधा देते ह�।
5. क��यूटर को एक टीवी या �ोजे�टर से जोड़ने क� िलए दोन� मशीन� पर एक समान पोट� होना चािहए िफर उ�ह� 

कने�ट करने क� िलए उपयु�त क�बल की आव�यकता होती है। जैसे:- USB, HDMI , VGA

6. �माट�फोन को USB क�बल से  PC म� कने�ट करने पर ��ीन पर यूएसबी कने�ट�ड सूचना को �पश� करते 
है, और  PC म�    ऑ�सन क� �ारा फाइल� को �थानांत�रत करते ह�।माउ�ट

1.  

 (a) CTRL+E   (b) ALT+F4    
 (c) Right Click-->Eject  (d) Window key +R--> Eject (c)

2.  
 (a)    (b)     (c) K7   (d)         (d)

3.  
 (a)    (b)     
 (c)     (d)    (a)

4.  
 (a)    (b)     
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1. 
 (a)  (b)  (c)  (d)  (b)

2. 
 (a) Unique Identification Authority of India-UIDAI
 (b)  (c) a or b  (d)  (c)

3. 
 (a)  (b)  (c)  (d)  (a)

4. 
 (a)  (b)  (c) a or b (d)  (c)

5. 
 (a) 
 (b) UIDAI 
 (c) a or b  (d)   (c)

6.              
Iris Scans             

 (a)  (b)  (c)  (d)  (c)

7. 
 (a)     (b)   
 (c) a or b  (d)   (c)

8. 
 (a)  (b)  (c)  (d)  (d)

9. (Indian Rail/IRCTC) (PNR) 
(a) Passenger Name Record  (b) Public Name Reservation
(c) Personal National Record (d) None of the above (a) 

10. 
 (a) https://uidai.gov.in (b) htts://uidai.gov.in
 (c) http://uidai.gov.in (d)   (a)

11. 
 (a) 
 (b) 
 (c)  (d)  (a)

12. 
 (a) OTP (b)  (c)  (d)  (a)

13. 

14 (Exploring Common Citizen Centric Services)
ukxfjd dsfUnzr lsokvksa dh tkudkjh
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Vijay PublicationsComputer Question Bank 32
 (b) Unique Identification Authority of India

(c) Universal Identity Authority (d) None of the above (b)
58. (TDS) 

(a) Time Deposit Scheme (b) Total Deposit Scheme
(c) Tax Deducted at Source (d) None of the above (c)

 
Ø https://uidai.gov.in 


Ø (http://tin.tin.nsdl.com/pan/form49Adsc.html) 

NSDL-National Securities Depository Limited

Ø     Additional Authentication     
Security QuestionsSecurity Questions 
Authentication 


Ø ITR www.incometax.gov.in 
Ø   PSK PSK

Self-Attested 
Ø Passport www.passportindia.gov.in 
Ø(http://www.indianrail.gov.in)

Ø     (http://www.enquirt.indianrail.gov.in/ntes/)  
(Real Time)(Running)
(Live Running Status)
             Ø

https://rsrtconline.rajasthan.gov.in

v/;k; 14INTERNAL ASSESSMENT
1. ?
 (a)  (b)  (c)  (d)  (b)

2. ?
 (a)  (b)  (c) a or b (d)  (c)

3. ?
 (a)   (b)  
 (c)  (d) : (c)

4. (PAN)?
 (a)  (b)  
 (c)  (d)  (b)

5. ?
 (a)  (b) 
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1.  
 (a) (b) (c) (d)  (b)
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
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(http://www.gis.rajasthan.gov.in)
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 
  3D GIS 


   w 



Ø 



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v/;k; 15INTERNAL ASSESSMENT
1. 
 (a) (b)  
 (c)   (d)  (b)

2. 
 (a) (b)  
 (c) 
 (d)   (b)

3. (SSO) 
 (a) (b)   
 (c)   (d)  (c)

4. 
 (a) (b)  
 (c)  (d)  (d)

5. 
 (a) (b)  
 (c)  (d)  (d)

6. 
 (a) (b)  
 (c)  (d)  (b)
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